Digital Audio I _Pro Tools Study Notes 
This is a ”quick study outline” only- it does not contain “everything”. Instead it is a quick summary. Not guaranteed to be complete or to cover everything! This document is not meant to replace class work and detailed study of the Pro Tools text books and manuals, which contain much more complete information.

Mac COMMAND = Windows CONTROL

Mac OPTION = Windows ALT “all or opposite”
Mac CONTROL = Windows START/WINDOWS

Pro Tools 101 Notes – first few Chapters

Pro Tools Systems


1. HD – PCI based


2. LE – Host based


3. M Powered – Host based

Turn ON a Pro Tools System:

1. Expansion Chassis

2. External HDs

3. Control surfaces

4. MIDI interfaces & devices

5. Pro Tools Audio interface

6. Computer

7. Audio monitoring (amps, speakers)

Hardware Buffer: 

Lower = reduce latency for recording

Higher = more processing/effects; mix down

CPU limit:


Lower = more CPU for screen re-draws


Higher = more CPU for RTAS/Pro Tools

You can’t hide/remove Main Time Scale ruler
Sub Time Scale – way to choose/change is pop-up menu (triangle) to right of it on its display

Folder Hierarchy

Session Folder contains:

1. Pro Tools Session File (version 5 – 6.9 = .pts, version 7 = .ptf)

2. Audio Files (whole file regions stored in here)

3. Fade Files

4. Region Groups (not same as audio regions)

5. Session File Back Ups (only if auto save preference is on)

6. Video Files are created automatically when digitizing video into a session using Avid Mojo or AV Option/V10. Pre-existing QuickTime files that are imported into a session are stored in their original location. A video files folder needs to be created manually and the .mov file needs to be copied to this folder for greater session portability. 

SD II format is only supported on Mac’s and supports up to 48KhZ sampling.

When recording, Level slider (fader) does NOT adjust record input gain, ONLY monitoring level.

Edit Modes and Tools

Slip Mode – Allows you to freely place regions. What happens when you cover all or part of a region with another region?

If you cover it all – it’s gone w/o warning!

If you cover part (then move new region 

away), it deletes audio, leaving a “hole” which can be repaired via trimming and/or Heal Separation.  Source Audio files (on disk) are not affected.

Stereo tracks can be placed on 2 adjacent Mono tracks!

Shuffle mode – “like a magnet”, no “holes” (gaps)

Spot mode – place region at pre-determined time

Grid mode – be careful of, and understand, Absolute mode vs. Relative mode

Temporarily suspend Grid mode (and be in Slip mode) by holding Command (control) key

Nudge moves regions in increments with +/- keys based on nudge value.

Deleting/Copy/Moving Audio

Deleting a selection in the middle of a region will give you THREE byproduct regions: the one you delete, and the two on either side that remain.

Option (alt)-drag a region in a track, using grabber, to make a copy and drag it into place.  Makes a copy rather than moving the region.  You end up with two.

Clear is identical to Delete
Locked region (Command-L) can’t be moved or trimmed etc., BUT it can be accidentally deleted if you (1) record over it, or (2) cover it with a new region you drag in from the Regions List.

Trimming – to “reverse” the direction of the trim tool, hold down Option (Alt) key.

In Slip mode, you are allowed to “trim” (reveal) such as to cover over another region (thus “muting” it). 

Trim To Selection Command (Cmd (Ctrl) T) – acts sort of like a Crop command in Photoshop – crops off the start and end portions outside your selection.

Trim Start (or End) to Insertion (where cursor currently is) is available in the Edit menu.  NOT avail while in SHUFFLE mode though!
Chapter 3

New Sessions

Select File Type: wav, aiff, SDII (Mac Only)

Sample Rate: Depends on system (M-Box supports up to 48kHz, HD up to 192kHz)

Bit Depth: 16 or 24

I/O set up: last used or stereo

Create New Tracks

Track Format:

Mono or stereo on LE and M Powered, can be 5.1 channel on HD

Track Type: 
Audio

MIDI

Instrument (Aux & MIDI combined)

Auxiliary Inputs

Master Faders (Do not take up voices. Use freely)

Deleting Tracks does not remove audio files from session. Cannot Undo Delete Track Command.

Scrolling options – 3 on LE systems. HD systems have 5; 2 continuous modes only on HD.

Playback Cursor: non-blinking

Edit Cursor: blinking


(They will be same if playback stopped AND


the Link Edit & Timeline Selection enabled)

Playback Cursor Locator: 

If you can’t find (see) the playback cursor, you can click the small right triangle in the rightmost area of the main Time base Ruler 

Setups > Preferences > Operations


“Edit Insertion Follows Playback”


If this is enabled, playback/stop acts like


“pause” on a tape deck, otherwise playback


Stop causes playback cursor to return to 

wherever you started playback.  Leave it

disabled if you want to keep a selection 


“selected” after playback stop.

Chapter 4

Preparing to Record

General Steps

1. Check Hardware Connections

2. Create Tracks

3. Set Track’s Input Path

4. Record Enable Track

Track Fader only adjusts playback level – it doesn’t affect input level!

Recorded Audio Files are named after track names.

Audio Files can be renames (dbl-click with grabber tool).

Quick keys for recording:

Command + space bar

F12

3 on number pad if number pad is set to transport mode in preferences

Removing regions from a session is very different than deleting files from a hard drive!

“Clear Selected” from regions list menu is how you remove regions from a session or delete regions, files or both from the hard drive.

You can “Select Unused Regions” then clear them, or “Select Unused Except Whole-File Regions”.

***** Deleting files CANNOT be undone! *****

Chapter 5

Importing Audio

File types accepted: SD II, AIFF, AIFC, WAV, BWV

Default for Mac and PC Pro Tools is BWF as .WAV file type (extension)

MP3 allowed with optional MP3 software from Digi

Sound Resource File (Mac) works too, but not useful

Stereo files are SPLIT MONO, not interleaved.

Upon import, Pro tools converts any files as necessary, such as splitting Interleaved Stereo files into two (L, R) split stereo files.

Mbox: 44.1 kHz or 48 kHz only

Digi001,002, 003: this plus 88.2 and 96 kHz

TDM/HD: these plus 176.4 and 192 kHz

All files in a given session must be the SAME bit depth and sample rate; upon import of any other, it is converted (to new files) by Pro Tools.

Import dialog box his a LOT of options.  p. 196, 197

Including ability to bring in Regions if they have been saved with audio files.

Weird: If you ADD a file with wrong sample rate, it’ll be accessible, but play at wrong speed.

ALSO, you can “Import Audio to New Track” from FILE menu.  Each file/region will go into its own track, placed at the start of the session. IT’LL DO MULTIPLE TRACKS FOR YOU, too!!

You can also import via the Workspace (“DigiBase Browser”) by dragging audio files directly to the Audio Regions List area in Pro Tools.

ALSO – from the Workspace, drag files to empty space in your timeline, and new tracks will be created for each file too!

LASTLY – you can drag audio files from Windows or Finder directly to the Pro Tools application’s icon or alias (shortcut), to import the files. (Aka Batch Importing)

On Mac (only) you can do “Movie…Import Audio from Other Movie”, to import audio from a CD.
[Note: works like in Media 100: QT file created, then two split-audio L/R files created.]

AUDITION from the Regions List by Option (Alt) clicking the filename.

Chapter 6 
MIDI

(It’s assumed reader knows basics of MIDI itself)

Audio is Sample based – audio regions – “absolute location” – doesn’t move if tempo changes

MIDI data is “Tick” based, “relative location”, i.e. MIDI regions will move if tempo changes in session.  

Also, it’s sometimes said that “MIDI is event based” – an event such as a note-on happens at a specific time.  Audio data (samples) not stored in MIDI files.

Usually use Bars & Beats time base ruler for MIDI:

     Bar number | Beat number | Tick number

960 – the number of ticks per quarter note (that is, very high resolution of recording/playback of performance timing detail)

Conductor Rulers (tempo, meter, markers) – useful for MIDI and Bars-and-beats based editing.

Notes View = “piano roll” view of MIDI notes

Regions View – shows notes, but they cannot be individually edited.  Regions act as “containers” for MIDI events (notes, other MIDI data).

Velocity View – volume “stalks” allow editing of volume of MIDI notes.

The “meter” on a MIDI track is a Velocity Meter, showing MIDI velocity values 0-127.

Transport window can show optional MIDI Controls.

Wait For Note; Metronome Click; Count-off; MIDI Merge; Tempo Ruler Enable (aka Conductor)

MIDI Merge – not same as hardware MIDI merge device.  Instead refers to “drum-machine-like” recording where each “pass” adds MIDI data to already recorded MIDI data rather than over-writing previous takes.

Conductor – when selected, Tempo Map for session used.  When de-selected, Manual Tempo setting is used; type in a tempo or use Tap Tempo.

MIDI Thru – used to “forward” MIDI data to sound-generating device for monitoring.  Turn ON via Option > MIDI Thru in menu.

Disable LOCAL CONTROL on MIDI keyboards that generate their own sounds, to avoid “double” MIDI notes.  If you don’t, Pro Tools will “forward” notes back to the keyboard, AND the keyboard will also play notes via its internal sending of data from what you play to its internal sound generation engine.

MIDI Click – create an AUX track, insert the Click plug-in.  It’ll follow any Tempo changes.  NOTE – you change note value for clicks in Meter dialog box.

Default Meter – 4/4 - you can change Meter (musical “time signature”) anywhere in a session.

You can insert Tempo and/or Meter changes via the MIDI menu, or via the appropriate buttons in the Transport Window’s MIDI section.  If “Conductor” button is unhighlighted, Tempo will be manually settable, and session will ignore any Tempo change events on the Tempo track (ruler).

Remember that Command (Control)-drag while changing a slider value will allow finer control. 

Virtual Instruments – done through AUX tracks or Instrument tracks.  Create an AUX track, use Inserts to select virtual instrument.  Then, use MIDI track’s Output selector to route the MIDI data to the virtual instrument. 

Exact steps for MIDI recording are on pp. 133 - 135.

Pencil tool turns into Eraser for MIDI notes by clicking Option (alt) while Pencil tool active.

Chapter 7 

Selections

Time Line selections are indicated by blue up and down arrows (red if a track is record enabled).

Link Time Line Edit Selection allows you to select on a track and the timeline simultaneously. Normally this should be on.
Selecting during Playback: Use down and up arrows for in/ out points. Hold down shift to adjust in/out points with selector tool.

Tab to Transients:  Goes to next “spike” on track.

Undo: 32 levels of undo is the max

      Cannot undo:


Delete Track


Close Session


Clear Audio from Regions List


Destructive Recording

Memory Locations

999 Total Memory Locations

Press ENTER (on keypad) to store Mem Loc in next available slot

Or press period (.) number then ENTER (on keypad)

Can store as Marker, Selection, or None

Recall mem loc:   .nnn.

Or click marker


Or select in Mem Loc window

Auto Name Mem Loc: if you have selected Marker


as your default type, name will be “Marker nn”

Else name will be based on Main Time Scale

Change/re-define a Mem Loc:

1) show mem loc window

2) put system in desired new state

(cursor loc, selection, track height, etc.)

3) Ctrl-click (right-click on PC) Mem Loc 

button you want to change, or use 

.nnn <enter>

4) Make changes in Mem Loc dialog box

5) Click OK

Delete Mem Loc: (1) show Mem Loc window, (2) Option (alt) click mem loc # to delete that mem loc

OR select a range in the Markers ruler, and press DELETE key

Make a selection between two Mem Locs: Click the first Mem Loc, hold SHIFT, and click the 2nd Mem Loc.
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Using Fades

Fades are actually new audio files, in Fades folder.

Fades are first calculated in RAM, then rendered to disk as a fade file.

Make a selection, Edit>Fades or Command (Ctrl)-F

3 major types: Preset (7 of them, not editable), 

 Standard (editable)

 S-Curve (editable)

Smart Tool can create fade in/ outs and x –fades

(Track height must be medium)
Edit existing: double-click w/Grabber

Delete: Click w/Grabber, press Delete key

Delete one or more: make a selection including fades, then Edit > Fades > Delete Fades.

Trick: You cannot cross fade between two FILES, only two REGIONS.  Reason is there must be “more media (samples) to fade from and to, beyond region boundaries”.

You can Trim fades from beginning OR end, using Trimmer tool.

Trimming fades in Shuffle mode may affect timing, sync, and position, just like regular Shuffle-mode editing.

Cross fades do not have to be “centered” around a splice point.

Link: Equal Power – retain more of their amplitude longer, versus Equal Gain.  Can avoid volume drop sometimes occurring with Equal Gain cross fades.

Link: Equal Gain – can avoid clipping that sometimes occurs with Equal Power cross fades.

“None” option in Link means the outgoing and incoming fades are independently editable.

Use DITHER option when fading low-level signals or fading in/out to/from silence.

You can do Cross fade between two tracks [like Media 100 or Premiere] that overlap.
Batch cross fades: Select a group of regions, then Edit > Fades; dialog box will come up with many options (p.252)

Chapter 9-10 

Mixing

Using Inserts

4 kinds of processing: TDM, HTDM, RTAS, Audio Suite

Only HD is PCI based; rest use computer’s CPU.

Only Audio Suite is NOT real-time

On ver 6.9 and below (HD sys only), RTAS can only be used on an Audio track.  LE systems allow it on Aux, Master too.

HTDM plug-ins function just like TDM but use host CPU, only available on TDM systems.

RTAS restrictions (HD sys only): not available “below” TDM/HTDMs (ver 6.9 and down only) That is, they must be first (above) any TDM/HTDM plug-ins).  Also, RTAS plug-ins bypassed (on TDM systems) when track is record-enabled or not set to auto-voice. 

HD/TDM systems: up to 128 internal sends and busses Plus availability of hardware inserts/sends limited only by # of I/O audio interfaces

LE systems: up to 32 internal sends and busses and hardware inserts/sends limited by H/W I/O

Inserts
Up to 5 on any Audio, Aux or Inst. Track, or Master fader.

Processed in order from “top” to “bottom”, A-E

Are Pre-fader EXCEPT on Master Faders (post-fader).

TDM plug-ins: very low latency, can be very complex, no impact on system performance (CPU)

RTAS used on TDM systems to free up DSP power for other or more complex TDM uses

HTDM – since they can be placed on Aux tracks, they are useful for HOST-BASED virtual instruments

You can use a stereo effect on mono track, which converts output to stereo.

Hardware inserts: can be used to allow use of outboard gear for processing signals.  

You must assign the output and input using the SAME numbered hardware I/O in/out. E.g. you assign insert B to I/O 5, you use #5 input and #5 output.

Also, hardware inserts must use previously unassigned input/output number(s).

A stereo track will automatically give you choices of hardware I/O pairs for outboard insert processing.

You do not delete inserts; you select “no insert”.

Mono track – many effects have mono and stereo versions.  Using a Mono-to-Stereo plug-in “turns a mono track into stereo” sort of:  it will have 2 panners, 2 meters.

Track will still be mono in the sense that it has ONE input, but it must have a PAIR of outputs.

Multi-Channel plug-ins: apply same effect, with identical settings, to all channels.  

Multi-Mono plug-ins: allow (the option of) each channel in a stereo or multi-channel track, having different plug-in settings. Master link button must be turned off to adjust channels separately. (See Linking below)

Moving: You can move insert from one place to another, one track to another – if one already exists in the destination “spot”, it will be deleted and overwritten by what you dragged in.

Copying: Option click and drag. Must be to same track format (i.e. stereo to stereo).

Plug-ins can be inserted/changed/deleted during playback, but not during recording, with some restrictions:


Can’t drag/copy plug-ins during play or rec


Can’t insert/remove mono-to-stereo during 
play


Can’t replace one type with another during 
play


Can’t remove one that has automation

The Plug-In Window
It initially comes up when you add an insert to a specific track, but it actually allows you to manipulate any plug-in on any insert on any track!

Bypass button disables currently selected plug-in.  Allows you to compare track with and without this insert.  The insert shows as “blue colored” if it is currently bypassed. You can bypass via Inserts view by Command (ctrl)-clicking on the insert.

Target button – if lit (red), any other insert opened will replace its window in place of this one.  If unlit (grey), future inserts will each open in their own window, leaving previous insert windows as they were.

Linking – applicable to multi-mono plug-ins only.  Master Link (2 chain links icon) turns on linking of all channels versus ability to set each channel separately.

To see all channels, Option (alt) click the Channel selector

If you re-link later, you’ll be asked which channel to copy parameters from (to all other channels).

EQ-3 7 band plug-ins have 5 basic EQ types


Hi Pass


High Shelf


Peak/Notch


Low Shelf


Low Pass

EQ – 4 band – you can turn off bands with blue “in” buttons. Only 4 bands available – filters count as 2 each.

Using Sends and Auxiliary Inputs

10 sends per track, to hardware interface or to Busses. No sends on MIDI tracks or master faders.

Send View can show Assignments (for all 5) or details of A-E, F-J send (one at a time).

Individual send control shows Level fader and meter(s), Mute, Pan slider if applicable, pre/post fader toggle.

FMP = Follow Main Path, meaning the send pan will follow the pan control of the track it is on.

A mono track can have a mono or stereo send.  A stereo track can have a mono or stereo send. So there are 4 possible appearances for the Send Output Window.

Trick: if Send Output Window shows a pan slider or knob, then the send is Stereo (but the track may still be mono or stereo, indicated by one level meter or two.)  Also, the output (such as “Bus 1” or “Bus 1-2”) will indicate whether the Send is mono or stereo.

Post fader is the default.  That’s why the button is labeled “Pre” – if it’s unlit, the send is Post, if it’s lit, then it’s Pre-fader.

Send Output Window – shows more details, larger slider, other controls (automation modes, etc.

Panners on a stereo send can be linked or unlinked, and when unlinked, can be normal or reversed.

Returns (Auxiliary Tracks)
You have a send, you have to get its signal back into the system: create an Aux track!

You’ll initially get no signal from it; its input defaults to “No Input”.

Input is either a bus or a physical input from the audio interface.  Output can be the main mix output (such as Stereo 1-2) or any other output.

Now you can assign an Insert effect to the Aux track, so that effect will be applied to any of one OR MORE tracks that are SENT to this Aux track.  This is one way to conserve processing power, and to consolidate effects on similar groups of tracks, such as three background vocals all getting the same reverb treatment.

Sub-Mixes in Pro Tools

To create a sub-mix, there is not “sub-mix” track type.  You can use Master Faders (see below).  OR, create an Aux track, then route the tracks you wish to sub-mix via a bus to that Aux track.

This is not too different from using Sends and an Aux track to add an effect; difference is that you are simply “patching” the signal path in a different way.  You can use this Sub-Mixing method to apply FX to one Aux track and have it affect (for example) 3 vocal tracks that you are sub-mixing.

Solo-Safe Mode – useful for Aux returns and Aux sub-mixes, so they aren’t muted when you solo other tracks.  Command (Control)-click the Solo button to toggle this on and off.  ‘S’ button is grayed out in Solo Safe mode.

Master Faders

Allow control of output levels of (1) signals sent to physical Output, (2) or (2) via busses.

Another way to do sub-mixes.  Also useful for many other things such as:


1. Monitor the sum of all tracks going to a 
given output to make sure it’s not clipping


2. Control submix/submaster levels


3. Control stems (musical elements) for post


4. Controlling FX send levels


5. Applying inserts to all tracks sent to 
common Outputs

No DSP power used by Master Faders – use as many as you want!

Inserts are POST-fader, unlike for Audio or Aux tracks.

Therefore, useful for final Mastering of your session … add that final overall compressor or reverb etc.!

NOTE – Master Faders have no PAN controls, no Input selector, no Sends, no Mute, no Solo, etc. – just have:


Inserts


Level fader


Level Meter(s)


Output selector


Automation selector

Automating Pro Tools Sessions
Things that can be automated:


Vol, Pan, Mute – Audio, Aux & MIDI tracks


Vol, Pan, Mute – Sends


Vol – Master Faders


ALL Plug-in parameters

If group(s) are active, automation recorded to one group affects all tracks in the group.  BUT this only applies to things that are affected by Groups!  So, includes:


Vol, mute, send level, send mute.

All other automation parameters unaffected by Groups.

Pro Tools automation is much higher resolution than MIDI automation, so it’s recommended to automate Volume, Pan, etc. instead of the MIDI track’s data.

Automation Modes - 5 Major Modes

Auto Off: no automation plays back or is recorded

Auto Read: automation PLAYS only

Auto Touch: automation writing (updating) starts when a control is touched, and stops when that control is released.  Returns to any previous automated value by “Ramping back” to this value as determined by Auto Match parameter in Preferences…Automation.

Auto Latch: writing/updating starts when a parameter is modified; writing/updating continues even after control is released (no longer touched), as long as playback continues.  Updating only stops when playback is stopped.

Auto Write: writing starts for all enabled parameters when playback starts, and only stops with playback stops (i.e. touching/releasing had no affect on when automation data is recorded or not).  Erases any previously written parameters.

Trim Mode: (HD only)

Automation Enable Window (command-4)
Windows > Show Automation Enable – control over various automation details.

Auto Suspend: toggles on/off, affecting writing of all automation parameters on all tracks.

Auto Arm: Enable/disable various kinds of automation data writing (Vol, Pan, Mute, Plug-in, Send level, Send pan, Send Mute).

Preferences…Automation 
You can enable or disable faders moving automatically as fader-level automation data is “played”. 

“Write Switches to Touch after Pass” – a good safety idea is to leave this enabled.

Also has the following Group-related switches:

Mutes Follow Groups

Solos Follow Groups

Send Mutes Follow Groups


Send Levels Follow Groups

Auto Match Time – affects how Pro Tools returns a control (after automation writing stops) to previously written automation data.  Auto Match Time is how quickly Pro Tools returns a control’s value to previously recorded data after control is release (not touched anymore).

On tracks, to left of Track Type Icon (just above “vol” which is just above Track Name), are the Auto Match indicators.  Tell which way fader must move to get it closer to its original automation level.  Looks like two triangles, pointing in opposite directions, one above the other.

Automation writing (recording) is Undo-able.

New track placed in Auto Read mode initially.

Trick/tip: REC enable buttons do not enable/disable recording of automation – only of audio data.

Steps to automation:

1. Get mix set up (i.e. set faders, pans, plug-ins, etc to desired positions)

2. Set Automation Preferences

3. Go to Automation Enable Window and arm parameters (hint: only arm 1 at a time)

4. Set desired track(s) to write mode

5, Start playback

To view automation data, change from Waveform view to other views (Volume, Pan, etc.)

Breakpoint - Pro Tools term for an automation value (called a ‘node’ in some editing systems)

After one pass of automation data writing, use Touch or Latch modes to add more data, without losing all your current automation data.

Regular Trimmer tool can be used to move a whole track, or selection of breakpoints up or down “as a unit”.  New breakpoints (anchor points) will be automatically added to start/end of selection if needed.

Three possibilities:

     1. Trim a selection to adjust breakpoints within it

     2. Trim in a region to trim all breakpoints in the 
region

     3. Trim outside a region to trim ALL 
breakpoints (in the entire track)

Hold Command (control) key to trim breakpoints in a finer (more detailed) way.

Trim Mode (unrelated to use of Trimmer tool, above)

Only possible on HD (TDM) systems – works with the other automation modes, but allows “relative” instead of “absolute” value changes.  Called “delta value”.

In Trim mode, and if in Auto Write mode, non-trimmable parameters work as if you were in Auto Touch mode.

Differences: when Trim mode on: Auto Read mode can be used to “audition” trim changes.  Auto Write mode allows you to set delta (relative) values prior to playback.

Watch-Out: Also, in Trim mode, the preference “Write Switches to Touch After Pass” does NOT function!

Manual Write to Start/End/All (HD sys only)
Available with the Automation Enable window.  

Allows you to write automation values that you want to maintain over long periods of time, such as from “here” to end of session, start of session to “here/now”, etc.

Only works when you are writing automation data (in “Play” mode with automation writing in Touch, Latch or Write (or Trim) modes).  Does NOT work if transport (playback) is STOPPED.

If you have a selection made, the manual-write will be to start/end/all of that selection.  Otherwise it is to the start/end/all of the session.

Auto-Write on Stop works similarly, but does its thing when you press STOP (when you stop playback).

Automation Safe – protects a track, send, or plug-in from having automation data recorded.  Useful when you have automation you like and don’t want to risk over-writing it by accident.  Toggle for this is in Output and Plug-in windows.

Editing and Controlling Automation
Each type of automation is stored in its own playlist, but only one of each type - even if you have multiple audio playlists.

You can “thin” automation, that is, reduce the density of breakpoints in your automation playlist(s). It reduces the # of breakpoints, but leaves enough to sonically maintain what you intended with your automation moves. This will reduce the amount of CPU resources it takes to play automation, thus it’s less taxing on your CPU.

[These breakpoints act a lot like “nodes” or “keyframes” in other kinds of editing systems].

In Preferences…Automation, you can turn on Smooth and Thin Automation After Pass, and then select from 5 degrees of thinning from None, Little, Some, More, Most.

Can be done manually (using same Degree of Thinning setting as you set in Preferences) with File >Thin Automation, or Option+Command (Alt+Ctrl) T

Graphical Editing of Breakpoints

You can do many operations on them in much the same way as you do for editing audio data.

The number of possible vertical positions for a breakpoint depends on the type of automation data.  For example, Volume, Pan, EQ Frequency each has many possible values.  Mute and EQ Type have 2 to 6 possible values so operate in a “stepped” way.

Create a new breakpoint: Click with Grabber tool.

Move a breakpoint: click-and-drag it

Nudge: select one or more breakpoints, and then nudge in the usual fashion.

Dealing with groups: Editing automation data affects Groups - Hold Control (start) key down while doing an edit to restrict it to current track (i.e. to ignore group that this track is part of) for this specific edit.

Trimmer: use to move whole groups of automation breakpoints up or down in value

Pencil: can be used for simple as well as unusual/creative ways of editing/adding automation data

Cut vs. Delete: The “Cut” command adds anchor points at the start and end of a selection; Delete key just removes the selected breakpoints.  They ARE different!

Exception: if there is no automation at all when you cut, then no anchor points will be added.

Paste: Always pastes data to the same kind of automation playlist – even if that particular automation is not currently displayed.

Paste: When you cut/copy/paste AUDIO, all automation for that audio is copied/pasted too.

Paste Special: press Control (Start) key then choose “Edit > Paste”.  Allows you to paste similar data in way normally not possible, such as Mute Track data to Mute Send, or Send 1 data to Send 3, etc.

You CANNOT interchange automation data from Audio to/from MIDI tracks, or from continuous controls to discrete controls (such as Volume data to Mute data).

Delete a Breakpoint: Option (Alt)-click it with Grabber.

Delete group of breakpoints: SELECT them, press DELETE or select Edit > Clear.

To delete ALL automation playlists (vol+pan+mute+etc., ALL AT ONCE) … Select a range or whole track(s), then press Control+Delete (Control + Backspace)

Note: when a Region is moved, its automation data is moved with it.

To suspend automation playback & recording, use “Show Automation Enable” window, click (toggle) “Auto Suspend”

To suspend automation play/rec on a track, change “auto” mode to “auto off”.

To suspend specific automation types from rec/play, choose them from Track View menu, then Command (control) click directly on Track Display Format button.  This toggles it off, or back on if it was off already.

To suspend specific automation types for all tracks, do same as above but use Command+option (control+alt) click – toggles that parameter on/off for all tracks.

Bouncing to Disk
Mix internally to master file, or output a mix through the hardware (physical) outputs.

Dither is a form of randomized noise, only needed when going down to a lower bit rate (bit depth), to minimize quantization artifacts.

POW-r Dither plug-in can be used on Master Fader as a final processor.  20-bit and 16-bit settings.


1. Noise Shaping Type 1- solo instruments

     
2. Noise Shaping Type 2-for stereo 
recordings/mixes

     
3. Noise Shaping Type 3-for full-spectrum, 
wide stereo

Bounce-to-Disk: the most common method of internal mix down in Pro Tools.

   Bounces all audible (non-muted) tracks

   No extra voices required for the bounce.

Selecting and Bouncing; by default, If no selection is made, Pro Tools bounces all tracks for the entire session length.  If you do make a selection, all audible tracks for the length of that selection are bounced.

All inserts, sends, automation, etc. are “played back” in real time into the bounce file, so be sure your mix is exactly as you want it before doing the bounce.

To create a sub-mix, simply mute unwanted tracks.

All tracks must output to the same output pair (for stereo), and that pair is chosen in the “Bounce Source” pulldown.

Formats/Bounce Options:

SD II format for Mac only.  Goes to 48kHz only.  WAV (BWF) is the suggested file type for most applications.  WAV supports up to whatever your system supports (Mbox: 48, Digi002: 96, HD: 192)

WMA-9 for Windows systems only. 

QuickTime is available; MP3 is an option that must be purchased.

Format: Mono, Multi-Mono, or Stereo Interleaved. 

Bit resolution: can be 8, 16 or 24.

Squeezer: for 8-bit audio only.  Applies compression, limiting, gating to improve intelligibility of dialog or other simple audio.

Conversion quality: affects re-sampling (changing from Session’s sampling rate to a different sampling rate.

Convert during/After Bounce: affects when Pro Tools does file type, sample rate and bit-depth conversion.  Safest is “After”, use “During” for simple mixes with little or no Plug-in Automation or where Plug-in Automation not critical.

Bounce to QuickTime Movie:

Similar to Bounce to Disk. Used to create a QuickTime (.mov) multimedia file (Video and audio)

Quick Keys to Know
New Session

Open Session

Close Session

Save Session

Create New Track

Toggle Mix and Edit Windows

Transport Window

Memory Locations Window

Automation Enable Window

Separate Regions

Heal Separation

Cut

Copy

Paste

Clear

Select All

Record

Playback

Select from edit cursor to beginning of session

Select from edit cursor to end of session

Nudge beginning of selection earlier/ later

Nudge end of selection earlier/ later

# Pad Transport Functions:

Turn MIDI Merge on/off

Turn Click on/ off

Loop Playback

Loop Record

Play/ Stop

Record

Fast Forward

Rewind
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